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Basic Steps in Creating Objects

Commonly use terminology on a Windows interface:
MENU, ICONBAR, STATUS BAR

Creating objects

Click on this button on the Iconbar to open/close the Shapes window.
Alternatively, click on the Default menu then select Shapes window.

Click on this button on the Iconbar to open/close the Symbols window.
Alternatively, click on the Default menu then select Symbols window.

1 Select a shape from the Shapes or Symbols window.
There are 2 user design shapes in the Shapes window that can be used
to design own shapes.

2 Drag an area on the work space
3 Release the mouse button

Changing objects' properties
· A quick and easy way of changing an object's properties is to click on the object with the RIGHT 

BUTTON.
Another way is as follows:

1 Select an object by clicking on the object
2 Click on a menu that contains a desired property option, then select the option.
3 Click on OK button to accept changes.

Changing global properties
· A Quick and easy way of changing global properties is to click on the work

space (not on any object) with the RIGHT BUTTON.
Another way is as follows:

1 Make sure no object is selected (highlighted), to do this by clicking on
the work space area, not on any object.

2 Click on a menu that contains property options, then select a desired option.
e.g. Style menu for pen attribute, multi-cell grid or font attributes

3 Click on OK button to accept changes
· Any objects created from now on will inherit the current properties

Moving/Resizing objects
· Please see Object Information

Delete objects
1 Select object for deletion
2 Press the DEL key or select Delete option from the Edit menu

Creating new page/Advancing to next page



Click this button on the Iconbar to advance to next page.
If there is no next page, a new page is created.

Embedding a text-object into an non-text object
1 Select a non-text object for embedding text-object
2 Click on the TEXT button from the Shapes window
3 Click on the non-text object.

If the non-text object already had an embeded text-object, then the text in
that embedded text-oobject will be defaulted for editing.

· To automatically attach text-object to a non-text object everytime the non-text object is created,    
click on the Default menu, select Attach Text Object.

Saving objects
1 Click on the FILE menu
2 Select SAVE option
3 Enter a filename
4 Click OK

Print filename and page number on document
1 Click on OPTION menu
2 Select PRINT OPTION
3 Choose desired options
4 Click OK



Object Information

Select an Object
· Click on an object with left button

Select more than one object
· Can be done in either of 2 ways
1 Hold down the CTRL key then click on an object with left button.
2 Click and drag an area that covers desired objects

Resize an object
1 Drag (with left button down) on one of the corners of the highlighted frame

(see the figure above).    The object size will change according to the mouse
movement.

2 Release the mouse button when the object is sized to desized size.

Move an object
1 Move the mouse arrow on an object
2 Press the LEFT button and hold it
3 Move the mouse.    The overall frame of the object will be dragged along.
4 Release the LEFT button

Select a Shape

This window is initially displayed on the right side of the screen
Click on a desired shape for selection

Click on the button on the Iconbar to open the Shapes window if it hasn't 
been displayed.
Alternatively, click on the Default menu then select Shapes window option.

This is not a shape.    It is a mode that allows user to manipulate objects,
such as, resizing, moving, changing attributes (colors, patterns...)

This object allows users to design own line-shape

This object allows users to design own curve-shape



Select a Symbol

This is the Symbols window.    It is not displayed initially.

Click on the button on the Iconbar to open the Symbols window if it hasn't
been displayed.
Alternatively, click on the Default menu then select Symbols window option.

Draw a shape
· Make sure a shape is selected (see above)
· Drag an area on the work space (document window) by holding the left button down then move 

the mouse.

Link one object to another object
· A line-object CANNOT be attached to another line-object
· Similary, a shape-object CANNOT be attached to another shape-object



Icon Bar Information
· The IconBar is located below the menu

Bold font

Italic font - Affect globally if no object is selected (highlighted)

Underline font - Affect globally if no object is selected

Rotate selected objects n degree entered on the left of this button

Attach line object to non-line object

Detach all links associated with selected objects

Bring object to front

Bring object to back

Show previous page if any

Show next page or create new page

Hide or show the Shapes window containing objects

Rotating mode
To rotate an object in arbitrary angle, press and hold the left mouse button
on an object then move the mouse up to rotate up, move the mouse down
to rotate down.

If this button is down, object selection is automatically switched back
to the non-object selection after the object has been drawed.



Hide or show the Symbols window which contains a set of system symbols.
These symbols doesn't have flexible capabilities as the Shapes objects,
i.e. no 3D look, no shadow look, no background.

Connect and attach 2 objects by a line.
If the default attribute for LINE has arrow(s), then the arrow(s) is determined as follows:
          - If the Arrow at Start of Line is checked,    the arrow will be attached to the                object whose
position is above the other.
          - If the Arrow at End of Line is checked, the arrow will be attached to the
              object whose position is below the other.



Object vs Attributes
· This help will explain what attributes(colors,style) affect what objects
Pen Style
· Pen Style and Pen Size affect all objects
· Pen Arrows affect only line-objects
· Colors apply to all objects
General Property
· 3D Depth and Shadow Depth affect all shape-objects and few line-objects
· Text Alignment applies to only text-object

General Depth    applies to these shape-objects (on the left)
The value of the GENERAL DEPTH is in percentage of the overall
area of the object



Pen Style
· New attributes will be applied to selected objects if any.

Otherwise, it will be applied to global attribute.

Style and Size
· Affects all objects

Arrows and Arrow Length
· Affects only line-object



General Property

3D Depth:    Change the depth of the 3D look

Shadow Depth:    Change the depth of the shadow look

General Depth:    Change the shape itself

Text Alignment:    Change the alignment of the text-object.



Line Objects vs Shape Objects

These are line-objects that can be attached to shape-objects

This is the right-angle line with smart object connection.

Other shapes(including symbol objects) are shape-objects that can be attached to line-objects

Attach objects
· Only line-object can be attached to shape-object, not line-object to line-object, nor shape-object 

to shape-object
1 Click on a line-object
2 Hold down the CTRL key then click on a shape-object

Click this button on the ICON BAR
or select Attach Object from the OPTION menu

Detach object
· Click on an object (either line-object or shape-object)

Click on this button on the ICON BAR
or select Detach Object from the OPTION menu



Object grouping/ungrouping
Objects can be grouped(glued) together a a single object such that if one of 
the objects is repositioned, the rest will also be repositioned respectively.

· Grouping doesn't affect object resizing or object's property.    It only affects
movement of objects.

· If one of objects to be grouped has been linked with other objects(by a line),
it cann't be used for grouping.

Ungrouping
· To ungroup an entire group, the entire group must be selected.

Otherwise, ungrouping only removes selected object(s) from the group.



Smart Form Maker
How to select the Form Maker

Click on this button on the Shapes window until the word "Form" appears on the window caption.

Click on this button to select the form maker.
Then drag an area on the workspace to create an initial form.

How the Form Maker works

· The RED line is the TOP CONTROL LINE.
Any vertical lines optionally can be made to snap to the control line.

· The BLUE line is the LEFT CONTROL LINE.
Any horizonal lines optionally can be made to snap to the control line.

· Only 2 control lines can be made at a time, one can be TOP or BOTTOM,
The other can be LEFT or RIGHT.

Adding more lines
1 Move mouse pointer over the form.    Click with RIGHT BUTTON
2 Select adding vertical or horizontal line
· Note: To add lines that will have the same property with a specific line,

click on a desired line that will be duplicated prior adding new lines.

Form Text

Click on this button then click on a cell on the form to enter text.

Form Colors
· Change colors for cells only
1 Select the POINTER on the Shapes window
2 Click on a desired cell
3 Hold down the CTRL key, then click on other cells if necessary
4 Move mouse pointer over the form.    Click with RIGHT BUTTON
5 Select COLOR
6 To change text background color, click FOREGROUND.

To change text color, click on TEXT COLOR.
7 Click on OK to accept.

· Change color for cells without embedded text.



1 Select the POINTER on the Shapes window
2 Click on a cell without embedded text
3 Move mouse pointer over the form.    Click with RIGHT BUTTON
4 Select COLOR
5 Click FOREGROUND button to select desired color
6 Click on OK to accept.



Right angle line with automatic linking
How to connect 2 objects with right-angle line

Click on this button to select the right-angle line

1 Move mouse pointer over an object that will be connected with another object
2 Click on a point on the object as starting point of the right-angle line.

Make sure keep the LEFT BUTTON down.
3 Move mouse with the LEFT BUTTON down over another object.
4 Make sure the mouse pointer is on a desired point of the second object,

then release mouse button.
5 The right-angle line will be contructed accordingly.

Special notes
· Objects that are linked by the right-angle line are permanantly linked.

Other words, if one of the objects is deleted or selected to be unlinked,
the right-angle line will be deleted automatically.



Tree with flexible branches
How to select TREE shape

Click on this button on the Shapes window until the word "Flowchart" appears on the window 
caption.

Click on this button to select TREE shape.
Then drag an area on the workspace to create initial TREE.

Create more branches
1 Move mouse pointer over the TREE, click with RIGHT BUTTON
2 Select "Add 1 line" or "Add 2 Lines" or "Add 3 Lines"

Move branches around

Click on this pointer button

· Move mouse over the TREE to a desired line, then drag the line.



Circular Text
· This object allows text to be wrapped around a circle or an arc or naturally.

How to select Circular Text shape

Click on this button on the Shapes window until the word "Form" or "Flowchart" or "Misc" appears on
the window caption.

Click on this button to select Circular Text shape.
Then drag an area on the workspace to begin entering text.

Circular Text Styles
· COMPLETE CIRCLE:    The string of text will be calculated so that it will be

displayed completely in a circle.
· COMPLETE ARC:    The string of text will be calculated so that it will be

displayed completely in an arc (half a circle).
· NO COMPLETE CIRCLE/ARC: The string of text will be displayed from the

selected position then continue in a circular fashion until the end of the string.
· START AT 0 DEGREE: The string of text will start on the middle position of

the RIGHT side of the object.
· START AT 90 DEGREE: The string of text will start on the middle position of

the TOP side of the object.
· START AT 180 DEGREE: The string of text will start on the middle position of the LEFT side of 

the object.
· START AT 270 DEGREE: The string of text will start on the middle position of the BOTTOM side 

of the object.
· CLOCKWISE: Direction in which the string of text will be displayed.



Arrange Options
· Align

Aligns selected objects.    Alignment options are "align horizontally",
"align vertically", etc...

· Connect
Connects selected objects.    Connection options are "connect horizontally",
"connect vertically",etc...

· Rotate
Rotates selected objects N degree whose value is shown on the Iconbar.

· Send to Front
If an object is overlapped by other objects,    this option will bring the object
to the front.

· Send to Back
if an object is on top of other objects, this option will bring the object to
the back.    Other words, the object will be overlapped by other objects if any.

· Next/New Page
Displays next page.    If there isn't next page, a new page will be created.

· Previous Page
Displays previous page if applicable.

· Flip Horizontal
Flips points on selected objects horizontally.    That is, points on the left will
be moved to the right and vice versa.

· Flip Vertical
Flips points on selected objects vertically.    That is, points on the top will
be moved to the bottom and vice versa.

· Text Attachment
This will change how an embedded text-object is attached to a non-text object.    The change will 
affect locally in the object or globally in the enviroment.    If an object is selected before choosing 
this option, then change will affect only on the object.    Otherwise, the change will affect objects 
that will be created from now on.

· Text Alignment
This option is to change the way that text (string) in a text-object will be displayed.    If there has 
been any object selected prior choosing this option, then the change will affect only on the 
object.    Otherwise, the change will affect objects that will be created from now on.



Polygon Property
· Attributes for objects with multiple lines, sides as shown below

· New attributes will be applied to selected objects if any.
Otherwise, it will be applied to global attribute.

Number of sides/lines
· Update number of sides/lines

Sides/Lines length
· The length is specified in percentage of the whole object in vertical

and horizonal directions.

Round sides
· This is applicable to objects that have sides only, NOT lines.



Default Menu
ToolBar
· It is also called the IconBar which is located below the Menubar.

The ToolBar is shown if there is a checkmark on the item.

StatusBar
· It is located at the bottom of the main window.

It is used to show information about current settings
The StatusBar is shown if there is a checkmark on the item.

Shapes Window
· Contains shape objects used for drawing.

The Shapes window is shown if there is a checkmark on the item.

Symbols Window
· Contains symbol objects used for drawing.

The Symbols Window is shown if there is a checkmark on the item.

Background
· This is an attribute option for objects.

If it is checked, then the background of newly created objects will be filled with the background 
color.

Foreground
· This is an attribute option for objects.

If it is checked, then the foreground of newly created objects will be filled with the foreground 
color.

Background Grid
· If it is checked, then background grid of the work area will be drawn with

the current setting.    Default is checked.

Shadow
· This is an attribute option for objects.

If it is checked, then the style of newly created objects will have the shadow.
The shadow style can be changed in the general property

3D Object
· This is an attribute option for objects.

If it is checked, then the style of newly created objects will have the 3D look.
The 3D style can be changed in the general property

Attach Text-Object
· This is an option of whether or not to attach Text-Object to any newly created object.

Auto-off Drawing
· Option to automatically switch to the non-object drawing mode after the object has been created.

The same command can be accessed on the IconBar

Tip Arrow
· Put an arrow at the tip of a line

End Arrow
· Put an arrow at the end of a line



Features that you may not know
You can design your own shapes
Below are 2 user design objects that can be used to design own shapes.
Select them from the Shapes window

This object allows user to design own line-objects.    That is, the object consists of    a series of 
connections of points selected by the user.

This object allows users to design own CURVE objects.    The curve is shaped by user points.

Smart linking of 2 objects with right-angle line

This tool will allow users to connect 2 objects permanently with right-angle line.

Quick and easy way to change object's properties
· Click on an object with the RIGHT BUTTON, a menu of object's properties

will pop up.
· If not clicking on any object with the RIGHT BUTTON, then a menu of

global properties will pop up.

Scale Objects
· Objects in the current document page can be scaled to 50%, 75%, 150%.

Click on the OPTIONS menu then select SCALE.
"Scale 50%" means that the new size of an object will be half of the original.

Automatically attach text to new objects
Select "Attach Text To Object" from the Default Menu.
Make sure the item has a checkmark next to it.

· Any new created object will have text attached to it.    Other words, the user
will be prompted for text input after the object has been created.

Attach a line-object to another object
You can permanantly attach a line-object to another object.    That is, these objects are linked.    
Movement of one object will affect position of the other object.

Over 200 additional fixed symbols besides flexible shapes
These symbols are available in the Symbols window.

Click on this button on the IconBar to open up the Symbols window if



the window is not shown.

Click on this button on the IconBar to connect and attach 2 objects by connecting a line between 
them.    This option only applies to the shape-object or symbol-object.

Group/Ungroup objects
Please see Object Grouping

Print document name and page number
· Document name and page number can be printed on the document
1 Click on the OPTION menu
2 Select PRINT OPTION
3 Select desired options then click OK



Properties Dialog Boxes
General Property
General Property
· 3D depth
· Shadow Depth
· General Depth
· Text Alignment

Polygon Property
Polygon Property
· No of Sides/Lines
· Side Length(%) - by percentage
· Whether or not making round sides

Color Property
· Foreground Color
· Background Color
· Shadow Color
· Pen Color
· Text Color
· Arrow Color

Pen Property
Pen Style
· Style
· Size
· Arrow and Arrow Length



How to...

How to change properties of any object

· Click on an object with the RIGHT BUTTON, a menu of properties for that
object will pop up.

How to create more than one(1) page of document

Click on this button on the Iconbar to advance to next page.
If there is no next page, a new page is created.

How to print filename and page number on document

· Click on OPTION menu, select PRINT OPTION

How to know what page current being worked on

· Page number indicator is on the right side of the Status Bar which
is located at the bottom of the main window.

How to turn on the Symbols window

Click this button on the Iconbar to open/close the Symbols window.
Alternatively, click on the Default menu then select Symbols window.

What is the Symbols window

· The Symbols window contains additional shapes whose attributes(colors...)
are limited but offer a large number of selections.

How to know what shape/symbol is being selected

· If the Symbols window and the Shapes window are both being shown on
the screen, then the shape/symbol of the window that is on the top is
active (selected).

How to change text in a Text-Object

Click on this button on the Shapes window.



Then click on the Text-Object to modify text.

How to copy and paste an object

1 Select object(s) to be copied
2 Click on the COPY option from the EDIT menu or

hold down the CTRL key then press the letter C
3 Click on the PASTE option from the EDIT menu or

hold down the CTRL key then press the letter V

How to draw/design own shape

· There are 2 user-design objects, one for line-object, one for curve-object

This object allows users to design own objects.
The object is a series of connections of points selected by the users.

This object allows users to design own objects.
The object is a curve drawn by a set of points.

How to change page size

1 Click on the File menu then select Pint Setup
2 Select desired page size
3 Click OK

How to print document in portrait or landscape

1 Click on the File menu then select Print Setup
2 Select paper orientation
3 Click OK

How to put embedded text not in the center of an object

· There are many ways of placing the embedded text on an object
Basic steps are as follows:

1 Click on the Arrange menu, then select Text Attachment option.
2 Click on the Arrange menu, select Text Alignment option.
3 Create an object.
· Note: If an object is selected (highlighted) before doing steps above,

the object will be changed accordingly.      Keep in mind that what has been 
changed is just to change the object itself, not global setting.      To change global setting,    make 
sure no object is selected before changing setting.



How to move attached objects as a group whose lines connecting them remain unchanged.

· Drag any line that links 2 objects.    This action will move all objects as a group.



Keyboard
Insert Keyboard Shortcuts help text here



Shapes vs Symbols
Differences
· Shapes objects are flexible and dynamically created.

Most of these objects have all available attributes(colors,3D look, shadow look,...)
· On the other hand, Symbols objects are fixed and have limited attributes.

However, the Symbols objects offers variety of symbols.

Attributes that apply to Symbols Objects
· Pen Color (just this attribute)

How to open/close the Shapes / Symbols windows

Click on the button on the Iconbar to open/close the Shapes window.
Alternatively, click on the Default menu then select Shapes window.

This is the Shapes window

This is a user design object that allows users to design own line-shapes by connecting specified 
points.

This is a user design object that allows users to design own Curve-Shapes
whose curves are determined by specified points.

Click on the button on the Iconbar to open/close the Symbols window.
Alternatively, click on the Default menu then select Symbols window.

This is the Symbols window



User Design Shape
· Following is instructions to design own shape

This user-design object is used to draw line-object which consists of
connections of line segments

This user-design object is used to draw a curve-object whose curve is based
on a set of specified points.

1 Select a user-design object(see above) from the Shapes Window
2 Click on a desired point on the work area with the LEFT BUTTON
3 Move the mouse to the next desired point, then Click with the LEFT BUTTON
4 Repeat the step 3 as many as needed
5 There are 3 ways to end the drawing
· a)    Click with the RIGHT BUTTON
· b)    Double click with the LEFT BUTTON
· c)    Click outside the work area with the LEFT BUTTON
The mouse position of the last click to end drawing will not be counted as a part of points specifed by
the user.



Drag
DRAG means moving the mouse with the LEFT BUTTON down.
Move the mouse on a target object, press the LEFT BUTTON and
hold it while moving the mouse.    Release the mouse button when
done.
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